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Accessories Included:
•	 A, B, C, D, E, H, J, Quilter’s ¼” Piecing foot, R, S, Sensor One-Step Buttonhole Foot,  Sensor Q-Foot,  

Interchangeable Dual Feed with 2 feet, Straight Stitch Plate, 360x200 hoop, 260x200 hoop, and 120x120 hoop
•	 Over 680 stitches and 5 sewing fonts
•	 Over 620 built-in embroidery designs with 8 built-in embroidery fonts in three different sizes

1.	 mySewnet™ and WiFi capabilities including content and  
design streaming

2.	 JoyOS ADVISOR™ includes interactive tutorials, the  
user’s guide, and more

3.	 Large 8” color touch screen with capacitive touch for easy 
navigating and creating

4.	 deLuxe™ Stitch System which selects the best thread  
delivery method for your project, either Thread  
Portioning or Thread Tension

5.	 EXCLUSIVE SENSOR SYSTEM™ automatically and  
continuously senses and adjusts for any fabric thickness

6.	 Extensive stitch package including exclusive patented 
stitch techniques

7.	 Large sewing surface accommodates larger projects,  
nearly 10” (250mm)

8.	 You can create and embroider larger than life designs up 
to 360x350mm without re-hooping with the optional  
DESIGNER™ Majestic Hoop

9.	 Easily access over 620 built-in embroidery designs.

10.	 Electronic pulsing needle piercing power provides  
superior results when stitching through heavy fabrics or 
multiple layers

Top Selling Features

MASTER THE BASICS

Sell Up Features from DESIGNER TOPAZ™ 50 sewing and embroidery machine
•	 mySewnet™ enabled and WiFi connectivity
•	 Design streaming with optional mySewnet™ Library built-in
•	 JoyOS ADVISOR™

•	 Larger 8” capacitive touch screen
•	 Larger embroidery area 360x350mm optional hoop
•	 deLuxe™ Stitch System 
•	 Design Shaping
•	 Design Appliqué
•	 200 spm faster embroidery speed
•	 Over 475 more embroidery designs
•	 6 more embroidery fonts
•	 Additional patented stitch techniques
•	 Over 415 more built-in stitches
•	 Side-motion stitching up to 54mm
•	 4-way and 8-way directional stitching

•	 Straight stitch needle plate with sensor
•	 Interchangeable dual feed foot included
•	 Separate bobbin winding motor
•	 Resize with stitch recalculation in Embroidery Edit
•	 Design stitch out order edit
•	 Embroidery background color edit
•	 Undo/redo in Embroidery Edit
•	 Embroider stitches and buttonholes in the hoop
•	 Smart Save
•	 Real time clock, alarm, and stopwatch
•	 Design Select with Group and Ungroup
•	 Color Block Sort and Color Block Merge
•	 Free-motion ruler foot setting
•	 Advanced 4-step Design Positioning with app assistance
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Phase 1
Feature Technique Benefit

JoyOS ADVISOR™ 
FEATURE

Using the JoyOS ADVISOR™ feature

SELECT: Medium woven and Seam/Overcast

SHOW: Correct stitch is selected for that fabric and 
technique

SELECT: Medium stretch

SHOW: The automatic changes in the stitch and  
settings

Simple selection, instant setting 

•	 Best stitch
•	 Best stitch width and length
•	 Best thread tension/thread portioning
•	 Best sewing speed
•	 Best Sensor Foot Pressure
•	 Capacitive Touch Screen shows recommended 

foot, needle, and stabilizer or cord.

SEWS ALL  
FABRIC TYPES 
AND WEIGHTS

SENSOR  
SYSTEM DEMO 

FABRIC: Chino

SELECT: Stitch A:2

USE: Presser Foot A

SEW:

•	 Fold fabric in half.  Line up fold on stitch plate 
line.

•	 Step on the foot control to lower the foot and 
sew.

•	 	Sew off  fabric and stop.

•	 When you turn on your DESIGNER SAPPHIRE™ 
85 sewing and embroidery machine, select your 
fabric and sewing technique from the JoyOS  
ADVISOR™ menu. The DESIGNER  
SAPPHIRE™ 85 sewing and embroidery machine 
will automatically choose the best stitch, stitch 
width & length, thread delivery system, and presser 
foot pressure for the fabric and stitch you have 
selected.

•	 When you are ready to sew, there is no need to 
lower the presser foot, just step on the foot control. 
The presser foot will automatically lower. The  
EXCLUSIVE SENSOR SYSTEM™ will change 
the way you think about sewing!

x2

Touch Sensor Foot Extra Lift twice. •	 With a touch, presser foot rises to highest height 
and feed teeth lower automatically.

FABRIC:  Sweatshirt fleece

SELECT: Engage Needle Down

SEW:

•	 Fold the fabric into quarters.
•	 Sew onto the four thicknesses.
•	 Pivot, sew, pivot, sew, pivot, and sew.
•	 Sew off  the fabric and stop.
•	 Tap foot pedal: needle up. Tap again: needle 

down. Tap again.

•	 Sensor Foot Extra Lift allows easy access to thick 
fabrics.

•	 Pivot position – turning fabric, precise corners,  
appliqué.

•	 Sensor Foot Pressure chooses the perfect height 
for foot to float when pivoting.

FABRIC: 1 piece of  cotton and batting

Sew onto the fabric and batting.

•	 Stop, pivot, and sew. Continue sewing and  
pivoting on the fabric and batting.

•	 Sew off  the fabric and stop.

•	 EXCLUSIVE SENSOR SYSTEM™ uses presser 
foot pressure to automatically and continuously sense 
the fabric thickness and adjusts for perfect fabric feed.

•	 Specially designed feed teeth and box feeding system 
move the fabric and batting evenly and precisely  
without snagging.
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Phase 1
Feature Technique Benefit

FABRIC: Denim

SELECT: JoyOS ADVISOR™ feature, Woven Heavy, 
Seam

SEW:  

•	 Begin sewing on single thickness.
•	 Create pleats toward needle leaving single  

thickness space between pleats. Sew into the 
pleats.

•	 Stop sewing at raw edge. Press Selective Thread 
Cutter.

•	 Perfect even feeding over all weights of  fabric.

•	 Selective Thread Cutter pulls cut thread tails to 
the back.

•	 Please change places with me and experience the 
EXCLUSIVE SENSOR SYSTEM™ for yourself.

JEANS HEM

FABRIC: Denim

SELECT: Woven Heavy and Seam

SEW: 

•	 Fold denim in half, wrong sides together.
•	 Sew along the fold using 5/8” seam allowance.
•	 Fold the seam to one side.
•	 Topstitch fold down.
•	 Fold up bottom raw edge twice to form hem.
•	 Sew hem in place from the front side of  the 

jeans hem.

•	 Pulsating piercing power handles heavy duty  
projects.

•	 Electronic power drives needle penetration even 
at slow speed. 
 
 
 
 

Tip: have a sewn sample ready showing 16-20 layers 
of  denim sewn and a sewn sample of  about 32 layers 
of  quilting cotton sewn to show the amazing needle 
piercing power.
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Phase 1
Feature Technique Benefit

PERFECT 
REPEATING

BUTTONHOLES

 

SHOW: Buttonhole Sample

FABRIC: Medium woven chino and stabilizer

SELECT: Medium woven and Buttonhole on the 
JoyOS ADVISOR™ feature

USE: Sensor One-Step Buttonhole Foot

MEASURE: Enter the size of  the button on the 
Button Size Control

SEW: 

•	 Fold fabric in half  with stabilizer in the middle.
•	 Match the white line with the white crown on 

the wheel.
•	 Line the short toe of  the buttonhole foot along 

the fold of  the fabric.
•	 Press on the foot control and sew buttonhole.
•	 Reposition, repeat, and sew another. 

 
 

SHOW: Increase or decrease buttonhole size using 
sizing icon.

•	 Adjust buttonhole density.

•	 Sensor One-Step Buttonhole Foot creates  
perfectly balanced, one-step repeatable  
buttonholes.

•	 15 buttonholes - there’s always one that’s perfect 
for your project.

•	 JoyOS ADVISOR™ selects the correct style of  
buttonhole, stitch length and stitch width for the 
type of  fabric used.

•	 You can even follow the step-by-step  
instructions right on your screen! 
 
 

•	 If  you look at the base of  the machine you have 
a built-in button ruler so you can easily figure out 
what size to input on the machine. 
 
 
 
 
 

•	 You can adjust your buttonhole density on the 
screen.

EASY 
BLIND HEM

FABRIC: Medium Woven wool

SELECT: Medium Woven, Blind Hem on the 
JoyOS ADVISOR™ feature.

USE: Presser foot D

SEW: 

•	 Fold up hem on piece of  wool.
•	 Keep the fold along the inside of  the large toe 

of  the foot.
•	 Just catch the fold with the left swing of  the 

needle as you stitch.
•	 Adjust the stitch width and catch just a thread 

from the fold.

•	 Perfectly engineered blind hem foot (D)  
allows you to sew a beautiful blind hem.

•	 Do you get confused on how to fold your hem to 
achieve the right effect? Watch the tutorial right 
on the screen.

•	 Multiple needle positions allow for fine tuning.
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Phase 1
Feature Technique Benefit

MULTIPLE 
NEEDLE 

POSITIONS

 
 

 

 

FABRIC: Woven Medium chino

SELECT: Straight stitch A:2 

USE: Presser Foot A

SEW:

•	 Fold fabric in half.
•	 Keeping fold along the outside right edge of  

the presser foot, sew a seam. 
 

•	 Adjust needle position to the left with the 
Stitch Width icon. Re-align fabric as above and 
sew again. 
 
 
 

•	 Use the mirror image side-to-side to move the 
needle to the far right.

•	 Sew as above one more time.

•	 29 needle positions make it easy to sew cording, 
piping, zippers.

•	 Topstitching, under stitching, stitching-in-the-ditch, 
and edge stitching are also made easier with this 
feature.

APPLIQUÉ

 

FABRIC: 2” (5cm) square of  quilter’s cotton, 6” 
(15cm) square of  medium weight woven fabric and 
stabilizer.

SELECT: Stitch B:9, blanket or pin stitch

USE: Presser Foot B 

SEW

•	 Layer centered 2” (5cm) square on 6” (15cm) 
square and stabilizer underneath all.

•	 Line up the right side of  the small square with 
the red line furthest on the right on the foot.

•	 Adjust stitch position if  needed.
•	 Tap on the foot pedal to slowly get to the  

corner. 

•	 Activate Needle Down. Continue stitching and 
pivot at corner.

•	 Achieve a hand-look appliqué stitch effortlessly.   
 
 
 
 
 
 
 
 

•	 The Stitch Positioning feature mean accurate 
stitch placement along appliqué edge.

•	 Tapping on the foot pedal complete half  a stitch 
so it’s easy to get to the corner without going too 
far.

•	 With Needle Down active, exact stopping position 
is maintained as you pivot.
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STRETCH 
STITCHES

FABRIC: Sweatshirt fleece and ribbing

SELECT: Stretch Medium, Collars, Ribbing on the 
JoyOS ADVISOR™ feature

USE: Presser Foot B 

SEW:

•	 Cut a small neckline on fleece.
•	 Fold ribbing in half  lengthwise, stretch to fit curve 

of  fleece.
•	 Sew near fabric edge creating a neckline.

•	 Creates a seam that will stretch on knit fabrics.
•	 Seam/Overcast prevents raveling of  the seam  

allowance on woven fabrics.
•	 Watch a tutorial, on your screen, to learn how to 

create this neckline plus other neckline options. 
You have a sewing teacher at your fingertips.

DECORATIVE 
STITCHES

FABRIC: Woven medium cotton, sequins, scrap tulle 
or woven medium for dimensional stitch and stabilizer

SELECT: Show a stitch from menu K Omnimotion 
stitches. 

SELECT: Menu L (Dimensional Stitches) and choose 
an appliqué, pop-up or sequin stitch of  your choice. 

USE: Presser Foot as recommended on the screen 

SHOW: 

•	 Sample of  various decorative stitches
•	 Select various stitches to show how easy it is to 

scroll through stitches and menus.
SEW:
•	 Sample of  2 or 3 decorative stitches (at least one 

patented technique).

•	 The DESIGNER SAPPHIRE™ 85 sewing and 
embroidery machine has hundreds of  stitches to 
choose from, including patented stitch techniques. 
These techniques allow you to create dimensional 
stitches in sewing mode and there are built-in  
tutorials to show you how! 

•	 There are even decorative stitches up to 54mm 
wide. You will have unlimited creative options! 

•	 Stitch length and width are selected for you but 
you can easily override the settings to customize 
each stitch. 
 
 

Tip: Practice some decorative stitches in advance so 
you have your preferred go to stitches for this demo.

ALPHABETS/ 
MONOGRAMS

SHOW: Lettering and monogram sample

FABRIC: Woven medium chino and stabilizer

SELECT: Fonts, Brush Line Alphabet

USE: Presser Foot B

PROGRAM: Program the customer’s name

SEW: The customer’s name

•	 Press the Selective Thread Cutter while stitching.

5 different built-in fonts with upper and lower case  
letters, numbers and symbols:

•	 Block
•	 	Outline
•	 	Brush Line
•	 	Script
•	 	Cyrillic
Create quilt and other project labels.

•	 When you press the Selective Thread Cutter while 
the machine is stitching the DESIGNER  
SAPPHIRE™ 85 will automatically stop at the 
end of  your program, sew a tie-off  stitch, cut the 
threads, and raise the foot.
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Feature Technique Benefit
HEIRLOOM 
STITCHES

Show: Heirloom Stitch Sample

FABRIC: Woven light linen or other natural fiber  
fabric and stabilizer.

SELECT: Menu C ( Heirloom Stitches) C:8

USE:  Presser Foot B and a size 100 Wing needle

SEW: A row of  entredeux stitches.

•	 Specialty stitches are built-in for this beautiful  
technique. Grouped together in the C menu so 
they are easy to find.

•	 No need for time consuming hand work.
•	 Programming is possible to create your own  

heirloom insertions with beautiful decorative 
stitches.

QUILTING: 
QUARTER INCH 

SEAM AND 
FREE-MOTION

¼” SEAM

FABRIC: Woven Medium cotton

SELECT: Stitch Menu D (Quilting Stitches) D:1

¼” stitch

USE: Presser Foot A

SEW: ¼” seam

 
FREE-MOTION FLOATING

FABRIC: Woven medium cotton with batting

SELECT: Stitch A:2

SELECT: Free-motion icon

SELECT: Free-Motion Floating

USE: Presser Foot R

SEW: Some stippling stitches

•	 Instant setting for perfect ¼” seams when using 
the A Foot. The Quilter’s ¼” Piecing foot is  
included with your machine as well.

•	 Lots of  wonderful decorative stitches for quilting 
are built into your machine.

•	 Many other quilting feet are available.
•	 3 free-motion modes:

- 	Free-Motion Floating: foot floats freely over 
fabric while quilting

-	 Free-Motion Spring Action: foot moves up and 
down holding your fabric in place with each 
stitch

- Free-Motion Ruler Foot: designed specifically to 
use the HUSQVARNA® VIKING® Ruler Foot 
with quilting rulers

•	 Feed teeth drop automatically.
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WIFI •	 If  you are not already connected to WiFi – 
show how to connect. If  you are connected, 
simply touch the WiFi icon and show that you 
are connected.

•	 If  you are not logged into the mySewnet™ Cloud, 
log in. If  you are already logged in, touch the 
mySewnet™ icon to show that you are logged in. 

•	 Touch your File Manager tab. 

•	 Select the mySewnet™ Cloud folder.
 
 
*Note: You need to be signed into this machine 
with a mySewnet™ account with an active subscription
•	 Select the mySewnet™ Library folder.
•	 Search for “rose” and select a design.

•	 Your DESIGNER SAPPHIRE™ 85 sewing and  
embroidery machine is WiFi compatible. 

•	 You can set up a mySewnet™ Cloud storage for free. 
Then save designs from your machine or your  
computer to the cloud and access them wirelessly. 

•	 Your DESIGNER SAPPHIRE™ 85 sewing and 
embroidery machine is also updateable. When 
connected to the WiFi, you will be alerted if  
there is an update available and prompted to 
install it.

•	 The mySewnet™ Library opens up a world of   
opportunities. With a subscription you have  
access to over 5,000 designs. 
 

•	 The mySewnet™ ecosystem also consists of  free 
apps that allow you to digitize designs from 
photos, keep track of  your embroidery progress 
from anywhere, load an image of  your hooped 
project to the screen for easy placement and 
more!
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EMBROIDERY: 
CUSTOMIZING

 

SHOW: EMBROIDERY HOOP SAMPLES

FABRIC: Medium woven fabric with stabilizer hooped in 
120x120 hoop. Thread machine with 40 wt rayon thread 
and insert bobbin with 60wt embroidery thread.

SELECT: JoyOS ADVISOR™ feature, Embroidery,  
Start New

USE: Sensor Q-Foot

EDIT:

•	 Touch the Design Tab and note how the designs 
are grouped into categories for easy selection.

•	 Touch design A:9 to preview the Design File  
information. 

Tip: if  you will stitch this out, choose the outline  
version of  this design A:25
•	 Select the design and drag it into the embroidery 

field.
•	 Select hoop 120x120.

•	 Touch the design and drag it to the left side to 
show on-screen movement.

•	 Touch and hold on your design to bring up the 
Smart Tool Box. Select Duplicate and add another 
copy of  the selected design. Touch and hold to 
mirror image the design end to end. 
 

•	 Duplicate until at least 3 designs are on your 
screen.

•	 Select Rotate and show how easy it is to rotate a 
design 90° by touching the center of  the control 
wheel. Rotate designs on screen to make a design. 
 
 
 
 
 
 
 

•	 Open the Arrange tab and select all. Then 
group the designs. 

•	 Delete duplicate design by touching Delete to  
remove the selected design. 

•	 The DESIGNER SAPPHIRE™ 85 sewing and  
embroidery machine converts from  
sewing to embroidery instantly.

•	 Touch a design to preview the design size,  
number of  stitches and the color changes. The  
Capacitive Touch Screen lets you instantly  
select the design and drag it into the embroidery 
field.

•	 When you load a design the smallest hoop it will 
fit in will automatically be loaded which helps 
you save fabric and stabilizer. 

•	 All available HUSQVARNA® VIKING® hoops 
are stored on screen for simple selection.

•	 You can easily move your design anywhere you 
want it on the screen.

•	 You can alter your embroidery designs on the 
Capacitive Touch Screen by touching and holding 
on the design to open the Smart Tool Box. From 
here you can easily mirror image, duplicate and 
delete.

•	 Combine built-in designs for truly unique  
embroideries.

•	 Choose the rotate icon and rotate your  
design in 1° increments or rotate 90° with  
a single touch.

 
 
 
 
 
 

•	 Let’s delete all the designs from the screen and 
start over.
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•	 Select a new background color. Touch and hold 
the grid icon to confirm color and activate  
Alignment then close the window.

•	 Touch the Design Shaping icon. Select the square 
shape.

•	 Select the scale icon and using the controls in the 
corners of  the design box, scale the design down 
to approximately 100x100.

•	 Touch the Design Menu.

•	 Select design N:5 then touch and hold to load it. 

•	 Touch & hold the Set Number of  Designs box. 
Enter 20 on the keypad, touch OK to close the 
keypad. Touch OK at the bottom of  the screen to 
close Design Shaping.

•	 Open the Thread Color Edit tab.
•	 Choose Select All. 

 

•	 Touch the top color to show a color wheel of  
color choices. Choose a different color. 

•	 Touch the tab to close the window. 
 

•	 Touching Delete to remove the selected design.

•	 Select one of  the 24 different background  
colors to see what your design will look like on a 
specific color of  fabric or add a grid and activate 
alignment for easier design placement.

•	 Your DESIGNER SAPPHIRE™ 85 sewing and 
embroidery machine has a wonderful feature called 
Design Shaping. We can take a small design – or 
we could even use built-in stitches – and duplicate 
the design to fit a shape. There are 10 shapes to 
choose from.

•	 Your DESIGNER SAPPHIRE™ 85 sewing and  
embroidery machine has over 620 built-in designs 
to choose from.

•	 With just a few clicks we can turn this 1  
design into a beautiful embroidery.

•	 Change thread colors on the Capacitive Touch 
Screen – without using your  
computer. What color would you like?
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FONTS SELECT: Fonts tab/ Swirl 40

SHOW: 

•	 Choose first letter of  customer’s name and touch 
OK.

•	 Touch the center of  the Control Wheel to center 
the letter.

•	 Change color of  letter if  desired.
•	 See below to stitch the design.

•	 Quickly and easily personalize your sewing using 
the built-in fonts. With the 8 built-in  
Embroidery fonts and the QuickFont  
Program you will have lots of  fonts to choose 
from. 

•	 Easily combine fonts and embroideries and then 
view on screen before stitching.

DESIGN 
POSITIONING

PREPARE: Draw a straight line across the fabric 
about 1/3 of  the way down in the hoop.

EMBROIDER:

•	 Touch GO for Embroidery Stitch Out Mode.
•	 Verify your settings in the Embroidery Stitch Out 

window. Touch continue. Slide on hoop when 
prompted.

•	 Touch  the Design Positioning Icon.
•	 Touch Step 1.
•	 Touch screen to assign first crosshair position on 

the design’s lower left corner.
•	 Select Step 2 icon and drag design on screen until 

the needle is directly on the left end of  the drawn 
line.

•	 Select Step 3 and touch the screen to place  
second crosshair to lower right corner of  design.

•	 Select Step 4 and drag design on screen until the 
needle is directly on the drawn line.

•	 Stitch (see next step).

Tip: Show the Design Placement feature in the  
compatible app if  your WiFi connection is strong 
enough to support it.

•	 Unmatched accuracy for placing  
embroideries EXACTLY where you want them.

•	 Simple step by step process makes it very user 
friendly. 
 
 

•	 Ability to move designs in any direction  
eliminates the need to try to hoop fabric 
straight. This also makes it so easy to match  
designs for endless borders that look perfect.

AUTO SMART 
SAVE

(Demonstrate in the middle of  stitching the design)

•	 In the middle of  an embroidery, stop  
embroidering.

•	 Point out, and touch the Auto Smart Save icon on 
the screen.

•	 Turn off  the machine.
•	 Re-start the machine and touch the Recover Smart 

Save Position.
•	 Continue embroidering.
•	 When design is finished stitching, delete design 

from screen.

•	 No need to try and carve out large amounts of  
time to continuously embroider large designs. 
Auto Smart Save means you can do it in  
sections.

•	 No worries that an interruption in power will ruin 
your embroidery. Your DESIGNER  
SAPPHIRE™ 85 sewing and embroidery  
machine will save your embroidery status 
about every 200 stitches.

•	 Your opportunities are truly endless with the 
HUSQVARNA® VIKING® DESIGNER  
SAPPHIRE™ 85 sewing and embroidery  
machine.

VIKING, DESIGNER SAPPHIRE, DESIGNER TOPAZ, DESIGNER, JOYOS ADVISOR, EXCLUSIVE SENSOR SYSTEM, DELUXE, and MYSEWNET  are trademarks of  KSIN Luxembourg II, S.a.r.l.  HUSQVARNA and the ”H” Crown 
Device are trademarks of  Husqvarna AB and are used under license.  ©2020 KSIN Luxembourg II, S.a.r.l


